The T -Pain Engine Help
Documentation




Table of Contents

10 o Yo L0 o o o 1
Welcome to The T-Pain ENGINe ... e e e e e e neeenes 1
U ol 0 172 1 oY 2
(P4 e] (o]0 TR I IS 0] 1 a1=] gl T U] o] oo ] o ol r P 8

L0 T ol S = o o PP 9
10} /=] 1= L 9
1018 Vo I 1 1T G 13
T o) (= o 1 15

AL I = T T =1 1 1= S 23
o 1YY= T < 23
AN E= Y2 T 1= o o o 27
Y= 141 g To I Y o = 5 1 PN 29
] o] o 32

ST | 33
1o Y= T 11 0T 33
Y= 1T 0 1 35
= L o= o 1 37

BT 0Tt 13 40
2N olo] e | o Vo [P PP 40
Y= 1T 0 1 45
B 2 LS TRLIE 2= L1 T =1 oL 49

D I === [ o DT o o 1 53
1] 0 1 ] 53
1T 1 56
LI I (ol PP 57

The T-Pain EffeCt PIUgG-In. .o e e e e e et re e naeans 59
= 1] L= 59
o = o | o Vo [P PR 61
S5V 63
Y07 = 64
1) 0 PN 66

11 1 A I ==Y 0 T = 1o o o 67
= 1] ot 67
L= L o 1 o ] 1= 69
1 =T o= Y =T f o o 70
L=l 0 10N 0 2= 1 71
= L o= o 1 73
2Tl 0] e =T == 16 =Y o T 74



Introduction
Welcome to The T - Pain Engine

© 2011 iZotope, Imc.
All rights reserved.

Thanks for using The T-Pain Engine!

- the iZotope team

1Zotope

© Copyright 2001-2011 iZotope, Inc. All rights reserved.

iZotope®, iDrum® and the iZotope logo are trademarks or registered trademarks of iZotope, Inc.
T-Pain, T-Pain Effect are copyrights and trademarks of Nappy Boy Enterprises, LLC, used with

permission.
SoundCloud® is a trademark of SoundCloud Ltd, used with permission.
V 1.0.0.209 V 1.0.0.212
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1. INTRODUCTION

Authorization

Each purchased copy of The T-Pain Engine contains a unique serial number printed on the
Installer DVD sleeve that will resemble:

SN-TPAINBUNDLE-XXXX-XXXX-XXXX-XXXX
This one serial number will authorize your entire T-Pain Engine bundle:

The T-Pain Engine application

The T-Pain Effect plug-in

iDrum: T-Pain Edition
Once one of the above is authorized with your serial number, all others will be authorized.
Authorization
After installing your software, you will be prompted to authorize your software when first
launching The T-Pain Engine application.

Your computer must be fully connected to the internet.

Note : If your computer is not connected to the internet, you can refer to the section below
on Offline Authorization.

1. Click first on 'Authorize'

IZOtD p @ AUTHORIZATION

The T-Pain Engine v1.00.202

Thank you for using The T-Pain Engine. This copy will continue to run with
saving disabled for 10 day(s). After this period, the product will run with
limited functionality until it is fully authorized. Click Authorize to authorize
the product now. Click Continue to use the product and authorize later.

For details on purchasing The T-Pain Engine, please visit the iZotope
http://wwnw.izotope.com/store/purchase.asp

[ Autho[ize ][ Continue

Have a question about iZotope authorization? Please visit:
http:/fwwaw.izotope.com/authfag.html
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2. Next, enter the serial number in all capital letters as it is shown on your DVD sleeve.
SN-TPAINBUNDLE-XXXX-XXXX-XXXX-XXXX
3. You must also enter your name and a valid e-mail address.

Make note of the e-mail address you use to authorize your license. Your license and iZotope
account will be linked directly to this e-mail address.

1ZOtOp @ AUTHORIZATION

Please enter the following information:

Serial Mumber:  SN-TPAIMBUNDLE- 4
Mame: 3jghn Doe

E-mail: John Doe@johndoe.com

Country: [United States "]

i Authorize “ Cancel ”Advanced ::»::::»]

Mot connected to the Internet? You can use offline Offline
authorization. Authorization

Have a question about iZotope authorization? Please visit:
http://wwnw.izotope.com/authfag. html

4. When you have confirmed that your serial number and e-mail information is accurate,
click once more on 'Authorize'.

5. Lastly, click on 'Submit' in order to send your authorization message to the iZotope
servers.

If the authorization is accepted, click on the 'Finish' button to complete the authorization.
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IZOtO p @ AUTHORIZATION

Authorization Successful
The T-Pain Engine has been successfully authorized. If you have any

guestions about iZotope Authorization, please click the link at the bottom
of this window.

Have a question about iZotope authorization? Flease visit:
http://wawnw.izotope.com/authfag.html

Offline Authorization
Some customers choose to keep their audio workstations offline, and a simple offline
authorization option has been included.

Note : Ifusing The T -Pain Engine, you are encouraged to keep your workstation online in
order to take advantage of the application's Share and Listen featur es.

1. When first prompted to authorize your software, click first on 'Authorize’.
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1Zoto p @ AUTHORIZATION

The T-Pain Engine v1.00.202

Thank you for using The T-Pain Engine. This copy will continue to run with
saving disabled for 10 day(s). After this period, the product will run with
limited functionality until it is fully authorized. Click Authorize to authorize
the product now. Click Continue to use the product and authorize later.

For details on purchasing The T-Pain Engine, please visit the iZotope
http://wawnw.izotope.com/store/purchase.asp

[ Authorize ][ Continue

Have a question about iZotope authorization? Please visit:
http://wawnw.izotope.com/authfag. html

2. Next, click on the option for 'Offline Authorization' at the bottom of the authorization
window.

3. You will be given a unique Challenge Code that is specific to your computer only. Write
down or make a copy of the exact Challenge Code. It will look like this

IZ-TPAINBUNDLE-XXXXXXXX-XXXX
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: E IZOtODE AUTHORIZATION

Step 1: Write down the followina challenae code:
IZ-TPAINENGINE-F0203BDF-03F2-D39¢

Step 2: Go to a computer that is connected to the internet and
log in to your iZotope account (wwwi.izotope.com). In your
account under "Activate Software", select "challenge/response"
for The T-Pain Engine and type in the above challenge code.

Step 3: Download the authorization file from the website,
move it to this computer, then choose the file.

Browse...

| < Back || Mext> || Cancel |

Hawve a auestion about iZotobe authorization? Please visit:
http://wwaw.izotope.com/authfag.html

4. Next, using a system with internet access, login to your customer account at the iZotope
website.

http://www.izotope.com/store/account.asp

5. Click the 'Activate Software with a Serial Number' button, and submit your full serial
number.

6. Select the 'Challenge/Response’ option and enter your full Challenge Code copied in step
3.

7. After submitting your Challenge Code, you will receive a unique authorization file that
you then need to move to your offline computer.

8. Once the authorization file is copied over to your offline music computer using a network,
hard drive or USB stick, click the 'Browse' button in your authorization wizard.

account under "Activate Software”,

for The T-Pain Engine and type in th

Step 3: Download the authorization
move it to this computer, then choo:
Browise..

®
(<8

Have a aguestion about iZotope autho

¥ oo
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Introduction

9. Navigate and select the authorization file and click 'Next' to authorize your machine.

IZDtD p @ AUTHORIZATION

Authorization Successful
The T-Pain Engine has been successfully authorized. If you have any

guestions about iZotope Authorization, please click the link at the bottom
of this window.

Have a question about iZotope authorization? Flease visit:
http://wawnw.izotope.com/authfag.html
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1. INTRODUCTION

IZotope Customer Support

How to purchase the full version of The T-Pain Engine

If you are using the demo version of The T-Pain Engine and would like the full version, you
can purchase The T-Pain Engine direct from the iZotope online store as part of The T-Pain
Effect.

http://www.izotope.com/products/audio/tpaineffect

Once your purchase is complete, you will be sent an e-mail confirmation and a full version
serial number that can be used to fully authorize your current installation of The T-Pain
Engine.

Customer Support Policy

iZotope is happy to provide professional technical support to all registered users absolutely
free of charge. We also offer valuable pre-sales technical support to customers who may be
interested in purchasing an iZotope product. Before contacting iZotope support, you can
search our Product Knowledgebase to see if the solution to your problem has already been
published.

http://www.izotope.com/support/center

How to contact Te chnical Support

For additional help with The T-Pain Engine, please check out the support pages on our web
site at http://www.izotope.com/support or contact our customer support department at
support@izotope.com.

iZotope's highly trained support team is committed to responding to all requests within one
(1) business day and frequently respond faster. Please try to explain your problem with as
much detail and clarity as possible. This will ensure our ability to solve your problem
accurately, the first time around. Please include all system specs and the build/version of
The T-Pain Engine that you are using.

Note : You can determine the build nhumber by going to About in the Help menu bar of The
T-Pain Engine.

Once your support request is submitted, you should automatically receive a confirmation e-
mail from iZotope support. If you do not receive this e-mail within a few minutes please
check your spam folder and make sure our responses are not getting blocked. To prevent
this from happening please add support@izotope.com to your list of allowed e-mail
addresses.



http://www.izotope.com/products/audio/tpaineffect
http://www.izotope.com/support/center/
http://www.izotope.com/support/
mailto:support@izotope.com
mailto:support@izotope.com

Quick Start
2. QUICK START

Interface

The T-Pain Engine is a fun and simple way to make beats, record vocals and create songs
that you can share.

File Edit Effects BeatDrop Help

T P T

™
Loop () mont

Ry Ly
A PLAY/PALSE

Before diving in, let's take a look at an overview of what The T-Pain Engine has got going
on.

The T-Pain Engine has three Tracks for laying out your music.

One for your Beat:
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and two for your recorded Vocals:

Check your audio levels with both Left and Right Meters:

10



Quick Start

The T-Pain Engine's playback controls allow you to Play or Pause, jump Back to the
beginning, Loop, Rewind or Fast Forward, and Record your incoming Vocal takes:

Lo0P/ &) mopL

Mo ®

WY LIy
20 PLAY/PAUSE RLC

The FX button reveals controls for the T-Pain Effect to process your Vocals:

Set the Scale, Key and adjust the Style of the Vocal processing to fit your track:

11
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Majaor

|

Major Pentatonic

| Minor Pentatonic |
—— Custom ] it}
———— !

Click and hold on Beat Drop to temporarily cut out your Beat track:

Happy with your song?

Use the Export and Share buttons to save your track or share it with your friends:

Or, when you're ready for more, click the Listen button to explore the community of The T-
Pain Effect.

12



Quick Start

2. QUICK START

Sound Check

The Sound Check walk-through has been created to help guide you through the process of
getting your computer set up to record and playback your audio.

Welcome to The T-Pain Engine. Before you begin, Sound Check

will take you through a few steps to get you ready to record.

Exit Sound Check

Sound Check will be displayed when launching The T-Pain Engine for the very first time, and
is always available from the Help menu | Sound Check.

rop | Help

Contents
Sound Check
Check For Updates

About The T-Pain Engine

Important Tip:

13
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14

Before you start, we recommend recording while using headphones instead of
speakers - that way the sound of the speakers won't leak into the microphone as
easily.

Do not point the Mic at your speakers or loud feedback can occur.

If you don't have headphones, start with your speaker volume low, and set up your
microphone so it's not right next to your speakers.

Once you're either using headphones or your Mic is not pointing at your speakers,
continue through the Sound Check' walk-through's on-screen instructions.



Quick Start

2. QUICK START

First S teps

When you first open The T-Pain Engine, we need to make sure that audio is passing in and
out of your computer.

A Sound Check walk-through has been created to take you through setting up your
computer to work with The T-Pain Engine.

If you have not already done so, select Sound Check from the Help menu to make sure your
computer is set up for recording.

Once we have audio running in and out of The T-Pain Engine, we can get started!
Beat

1. Select your Beat track in the upper left

FIRRCE 0 TR
LHUUYE M IHHLH -

2. From the Beats menu on the left, double-click on a beat to load it as a backdrop
for your recorded vocal ideas.

15
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Note : Preview any beat by clicking on the small play/stop buttons beside each beat
in the list.

3. Each beat comes with multiple patterns marked with different colors for different
sections of the song, e.g. Verse 1, Chorus 2, etc.

4. Click anywhere in the ruler above your beat and press the play button to hear the
arrangement.

16



Quick Start

5. Click and drag to re-arrange your patterns,

or Click on the small drop-down button to swap out one pattern type for a different
one.

6. Click and drag the green flag to make your beat longer or shorter.

17
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Vocals
Now that we've got the beat the way you want it, time to get your Vocals in.

7. Under the Choose a Track area, select Vocal 1

8. Click once on the circular Record button in order to arm your vocal track for
recording.

9. Sing or talk into your Mic and you should see your voice in the Recording meter
on the left.

18



Quick Start

Note : If you do not see any movement in the meters when singing into your mic,
you may need to work through the Sound Check tutorial once more by clicking

10. By adjusting your singing technique or the input volume on your Mic, try to get
your Recording meter mostly within the Good section before recording.

11. When you’ve got your levels set, click the Play button and your Vocals will be
recorded into Vocal 1 track.

19
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12. Click the Play button again to finish your recording.

Note : If you are finished with your recording altogether, you can click again on the
Record button to take The T -Pain Engine out of record mode.

13. To record more, you can redo your vocal take on Vocal 1, or select Vocal 2 from
your Choose a Track area and repeat Steps 8-12.

FX
Now that you’ve recorded your audio, let’s set up our effects.

14. Click on the FX button to bring up the T-Pain Effect.

15. The Vocal key and scale of each Beat will already be loaded.

20



Quick Start

111 Chromatic 1
Major T

|  Minor 1
Major Pentatonic {

| I |

tonic h
= Custom

16. Use the Style sliders to adjust the character of the T-Pain Effect for both Vocal
track 1 and 2.

Mixdown

17. Next, use the Mixer controls at the bottom to adjust the levels of your Beat and
Vocals.

21
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18. When you’ve got your levels the way you want them, click Export to mix down
your track into a .wav file on your computer.

19. Click Share to upload an MP3 of your track to your account on SoundCloud, a
popular (and free!) online music sharing service. You will be prompted to create and
account if you don't have one already.

22
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3. THE T -PAIN ENGINE

Playback

The T-Pain Engine offers streamlined playback and looping controls to help you navigate
your Project.

Anchor
The anchor in The T-Pain Engine is represented by a single blue flag. It indicates where
playback will start when you press Play.

Click anywhere in the upper ruler of your display to position your anchor.

Once you've dropped your anchor where you would like it, press the Play button or hit
Spacebar to begin playback.

Playhead

23
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The playhead is represented by a golden triangle that moves along the time ruler during
playback.

When listening to your song during playback, the playhead will help indicate what part of
the song you are hearing at any given moment.

You can hit the Spacebar or Play button again to stop your audio playback.

Clicking the Back button will automatically return your anchor back to the very beginning of
your song.

Selections

Selections will allow you to grab pieces of your arrangement in order to more easily loop or
perform edits of your audio.

Left-click and drag left or right anywhere in your Vocal tracks view to make a selection. Your
selection start and end points will be represented by red flags.

By default, all selections will be made in Measures. You can change this however by right-

clicking in your tracks view, and setting the subdivision of your selection to the desired
value.

24
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1/16
1/8

1/4
1/2

v Measure

Select Snapping Off in order to make selections anywhere in time

Looping
Click the Loop Mode button in order to engage playback looping.

IJ f;.:\ mnnr

oA 1]hE S
s

Along the top of your playback ruler, loop points can be defined in your audio.

S .,”.'* ]”q'"q* .

Click and drag between the loop flags to shift both loops points left or right, and click and
drag on either flag to adjust the boundaries of your loop point.

You can also set your loop points quickly by first making a selection of the area you would
like to loop, and then pressing the Loop Mode button.

Your loop markers will automatically be matched to the same start and end point of your
selection.

End Point
Each song will have a specified end point defined by the green flag.

25
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Click and drag this flag either left or right to shorten or elongate your arrangement.

Note: When exporting or sharing, your song will end exactly at the defined end point. If you

find that some of your song is missing in your exported files, you may want to add a

measure or two of silence. To do so, simply drag the end point flag to the ri ght of where
your beats or recorded vocals end.

26
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3. THE T -PAIN ENGINE

Navigation

The T-Pain Engine's interface is split into three tracks: one for your Beat and two for your
Vocals.

Click and drag on the scroll bar along the bottom of your tracks in order to move your
arrangement left or right.

-

Loop/ (&) mopr

You can us the + and - buttons to the right of the scroll bar to zoom your arrangement in or
out.

Note : You can also use the mouse wheel to navigate. When the mouse is placed over your
tracks, the mo use wheel will zoom in and out. When the mouse is placed over the scroll bar,
the mouse wheel will move your position in the arrangement.

27
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3. THE T -PAIN ENGINE

Saving & Sharing

When you're ready to save your project or take your track out of The T-Pain Engine, there
are a couple different options.

Save Project

If you would like to save your project in order to come back and work on it later, from the
File menu, select Save Project As...

FICH Edit Effects Beat Dr

New 3N
I Open... F0
Save Project S

Save Project As...

Import Audio...
Import iDrum Kit...

Export Song... #=M

1 Money Dance.tpain

You can then specify a project name and your session will be saved as a .tpain file on your
computer.

All arrangements of your beat, your FX settings, as well as your vocal takes will be saved.
Export Song

The Export button will automatically render your entire song to a .wav audio file that you
can save anywhere on your computer.

Specify a file name and choose a folder on your computer to save your song to.
Note : A .wav file can be loaded into almost any media player, including iTunes. If you

would like to make an .mp3, you can do so inside of iTunes, whic h is available as a free
download from Apple's website.

29
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You can also select 'Export Song...' from the File menu to export your song as a .wav audio
file.

I8 Edit FEffects Beat Drn

New EN
Open... H#0
Save Project E

Save Project As... {+385

Import Audio...
Import iDrum Kit...

Export Song... . M

1 Money Dance.tpain

Share
You can click on the Share button to automatically render your song as an .mp3 and post it
to your own SoundCloud page.

About SoundCloud

SoundCloud is a free service that allows users to upload songs to their own SoundCloud
account. Once you have a SoundCloud account, you can easily share tracks with friends
through a variety of social media, including Facebook, Twitter, Tumblr, MySpace, email, and
more.

If you don't already have a SoundCloud account, you will be prompted to create one when
you click Share. If you do have an account, log in when prompted.

To configure your SoundCloud account for social media sharing, access your account on
SoundCloud's website and configure the Connections settings. There you can set the
defaults of which social media types will automatically get updated when you Share tracks
from The T-Pain Engine.

Select the "Submit to The T-Pain Effect Group" checkbox when Sharing to automatically add
your track to a SoundCloud Group dedicated to all creations made with The T-Pain Engine.

30
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This lets you show off your hot tracks to other T-Pain fans, and will also make you eligible
for prizes and other giveaways from iZotope and Nappy Boy.

31
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3. THE T -PAIN ENGINE

Listen

Click the Listen button to explore the broader community of The T-Pain Effect!

e Listen to and comment on tracks shared by other users via SoundCloud
e See which tracks are hot and which users are most prolifickemdash;it could be you!
e Stay updated on new T-Pain content, contests, and other product news

Note : The Listen button launches a web browser. Internet connectivity is required to access
online content.

32
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4. BEATS

Loading

With Beats selected from the upper left Choose a Track area, a drop down list of all
available Beats will appear in the middle left of The T-Pain Engine interface.

Use the scroll bar or your mouse wheel to move through the list of available beats for The
T-Pain Engine.

Click on the small Play and Stop buttons to the left of the beat name to preview any of the
available Beats in your list.

Select the Beat you want and double-click or click Open Beat to load it into your Beats
Track.

33
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|_rYRAN

Each pattern or section will be shown in your Beat track, pre-arranged in a song to get you
started.

Loading iDrum Kits

If you own iDrum already or have new iDrum kits you would like to work with, you can also
select &rsquor;Import iDrum Kit’ from the File menu to make them available in your Beat
list.

I File | Edit Effects BeatDrop Help
Mew Ctrl+M
Open... Ctrl+0

Save Project Ctrl+5
Save Project As... Ctrl+Shift+5

Import Audic...

Import iDrum Kit... l}

Export Song...
1 Money Dance.tpain

Exit

34
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4. BEATS

Selections

Once your Beat is loaded, you can single click on any Pattern clip in order to select it.

When a Pattern is selected, a thin white box will appear around the selected clip.

Click and Drag the clip Left or Right to move the pattern around in your arrangement

Multiple Selections
Hold the Control (PC) / Command (Mac) key when clicking on Patterns to select multiple
patterns at once, even if they are not adjacent to each other.

Hold the Shift key and click to select all clips in between the originally selected Pattern and
a newly selected Pattern.

35
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Editing
Once you have made a selection, from the Edit menu you can:

mm’ects Beat Drop

Undo ¥Z
Redo 8z
Cut #x
Copy F#C
Paste AT
Delete Selection &
Snapping >
Set Loop to Selection
Enable Looping

e Copy your selection to be pasted elsewhere by pressing Control-C (PC) / Command-
C (Mac) on your keyboard.

e Paste any previously copied Pattern over existing song content or onto the end of
an arrangement. Simply single-click on the ruler where you wish to place your
copied Pattern, and press Control-V (PC) / Command-V (Mac).

e Delete your pattern by pressing the Delete key on your keyboard.

When a Pattern is deleted, the entire clip is removed. Any Patterns occurring after

the deleted clip will slide down into place, replacing the Pattern that was just
deleted.

36
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4. BEATS

Patterns

Each Beat automatically comes with individual patterns for different sections of your song.
Patterns are loaded as individual blocks that are each one measure long. Each pattern or
section will be shown with varying colors in your Beat track to help visualize your
arrangement.

After loading a Beat, the available patterns or sections for that beat will be shown in a list
on the left.

Similar to the entire Beat, you can use the small Play and Stop buttons to preview any
individual pattern or section of your loaded Beat.

You can click and drag any particular pattern in the list directly on to your Beat track to
arrange the sections of your Beat however you would like.

37
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Note: Dragging a pattern onto an existing pattern will overwrite that section with the new
pattern.

You can also double-click on any pattern in the list to automatically add that pattern on to
the end of your song.

Clicking on the small down arrow in the left corner of each pattern will also display all
available patterns, letting you change around your patterns from within in the Track.

Versae 2

The green flag marker in your Track view represents the end point of your song. To extend
or shorten your song, click and drag the marker to the left or right.

If you are shortening your song, patterns will be removed from your Track arrangement.

The portion of the arrangement that you are removing will be remembered however, if you
decide to later extend your song.

38
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When making your arrangement longer, empty pattern blocks will appear in black, giving
you extra space to drag and drop patterns into.

39



Vocals
5. VOCALS

Recording

After working through the Sound Check tutorial, your voice should be passing through your
Mic and into The T-Pain Engine.

To begin recording, first select the Vocal 1 or 2 track from the upper left that you wish to
record your voice onto.

The Record button will blink red to let you know that you are in Record mode.
You should see the Recording meter on the left light up with your incoming voice.
The Recording Meter will show you the incoming volume of your Voice. In order to get the

best possible vocal sound, it is important to have good recording levels that are not too soft
and not too loud.

40



Vocals

For this reason, the Recording Meter is marked with Lo, Good and Hi regions to help guide
you and ensure that your incoming vocals are sitting within the right volume. You may need

to adjust the volume level you are singing at, or adjust your distance from your
microphone.

Note : If you cannot see your Vocals showing in the Meter, or your levels are too high or

low, be sure to run through the Sound Check tutorial in order to help set up your system to
get the best sound possible.

Once your levels are set correctly and your Record button is blinking red to show you that
Vocal track 1 or 2 is ready to record, simply press Play to start recording.

41
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To stop recording, press Play again.

If you make a mistake and wish to re-record your entire take, simply click the Record
button again and press Play to re-record your take.

Note : Any audio in the Vocal track you are re-recording will be overwritten by your new
take.

To remove any particular portion of your recording, you can simply select the portion you
wish to delete and press the Delete key.

For more info, refer to the Vocal Selections page.

Importing Audio
If you would like to take audio you already have in a file and bring it into your Project, you
can use the Import Audio... option from the File menu.

You can also simply drag and drop your audio file from any folder on your hard drive
directly in to either Vocal track.

Note : If your Vocal track already has audio present, the existing audio and the contents of
your audio file will be mixed together. If you wish to replace any existing audio with your
audio file, be sure to first select and Delete your existing audio.

Selective Recording

42



Vocals

If you wish to re-record only a particular part of your Vocal take, you can use selections to
define the start and end point of the section of vocals that you don't like. This ensures that

only the vocal parts you don't like are replaced and the other parts are preserved. This type
of recording is also called "punch-in".

When in Record mode, create a selection in your Vocal 1 or 2 tracks to selectively record
your incoming vocal for that selected portion only.

Selections made in Record mode are shaded in red in order to indicate the range that The T-
Pain Engine will be using to record your incoming vocals.

Be sure to make your selection on top of the Vocal track that you wish to record onto. The
selected track will be slightly darker.

To commence Recording, press Play with Record mode engaged, and when you reach the
selected portion, The T-Pain Engine will automatically begin to record your incoming vocals.

Tip: Before you press Play, you may want to place the playback anchor a measure or two
ahead of the punch-in point, so you can prepare yourself before you have to start singing!

43
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When the playhead has reached the end of your selection, your vocals will no longer be
recorded and any previous audio in your tracks will play back.
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5. VOCALS

Selections

Once your vocal take is recorded onto either your Vocal 1 or 2 track, the primary way to
select any portion of your vocal recording is to click and drag across the track you are
working in.

When clicking and dragging left or right within the track you would like to work in, the
selected area will be shaded and red selection markers will appear to mark that area.

To adjust a selection that has already been made, click and drag on either red selection
marker in the upper ruler.

Editing
Once you have a clip of audio selected, from the Edit menu you can:
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m Effects Beat Drop

Undo #Z
Redo 487
Cut X
Copy F#EC
Paste AT
Delete Selection &
Snapping »
Set Loop to Selection
Enable Looping

e Copy Yyour selected clip of audio to be temporarily stored for pasting to another part
of your arrangement. You can also press Control-C (PC) / Command-C (Mac) on your
keyboard.

e Paste any previously copied audio to the position of your anchor.

Having first copied any selected your audio, simply single click on where you wish to
place your copied audio, and press Control-V (PC) / Command-V (Mac).

Note : This will overwrite any audio that may be present with the pasted clip.
e Delete your portion of audio by pressing the Delete key on your keyboard.
Selective Recording
When in Record mode, you can use selection made in your Vocal 1 or 2 tracks in order to

selectively record your incoming vocal only for that selected portion.

Selections made in record mode are shaded in red in order to indicate the range that The T-
Pain Engine will be using to record your incoming vocals.
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Be sure to make your selection on top of the Vocal track that you wish to record in to. The
selected track will be slightly darker.

To commence Recording, simply play back your audio from before your selection while

record mode is engaged, and when you reach the selected portion, The T-Pain Engine will
automatically begin to record your incoming vocals.
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When the play head has reached the end of your selection, your vocals will no longer be
recorded and any previous audio in your tracks will play back.

Snapping

By default, any selections made will automatically snap to one measure increments. This is
to help ensure that any edits made from selections remain musical and line up properly with
your loaded Beat.

By right-clicking in your Tracks view, or under Snapping in the Edit Menu, you can change

the automatic snapping value to 1/2 note, 1/4 note, 1/8 or 1/16 notes, as well as turn
automatic Snapping Off.
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5. VOCALS

The T -Pain Effect

The T-Pain Effect is a real-time audio effect that is designed to correct any incoming vocal
pitches to a musical key or scale.

The T-Pain Effect works by first recognizing the pitch of the audio that is being played
through it, and then adjusting the pitch of that audio until it matches the nearest pitch of
the key and scale The T-Pain Effect is set to.

Key
Here you can define the root note or key that your vocal takes are in.

It is important to set an accurate Root Note as this can help the algorithm to determine the
best possible pitches for your particular session.
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Experiment with different settings in order to find the right key center for your track or to
explore new possibilities or vocal ideas.

Often times, using keys different from the 'correct' key for your track can point you to new
musical ideas that you may not have thought of otherwise.

Note : Each loaded Beat has a corresponding Key and Scale and that will be set
automatically when each Beat is loaded.

Scale

Here you can select to snap your incoming vocal pitches to either a Chromatic, Major,
Minor, Major Pentatonic, Minor Pentatonic or Custom Scale of your choosing based upon
your specified Root Note.
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Each Scale has their own unique flavor to fit your music so be sure to experiment with
different scale types in order to find what fits best for your particular track.

Working with a Scale type that may not be the 'correct' scale type for your music can also
help create new vocal musical ideas for your track.
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Chromatic
A Scale in which every note of every octave will be available as a pitch your vocals could be
corrected to.

If you are not sure of the Scale that your vocal takes are in, be sure to set your Scale to
Chromatic in order to get the best results.

Note : When in chromatic mode, as every pitched note is availab le for pitch correction, the
defined key has no effect.

Custom
When defining a Custom Scale, click once upon the notes of the keyboard you wish to
enable as options for The T-Pain Effect.
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The T-Pain Effect will use any notes that appear pressed down (darker) in your custom
scale.
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Style

You can use the Style control in order to control how quickly your incoming vocals will be
snapped to any particular note in your Key and Scale. This will essentially determine the
Style of The T-Pain Effect's processing on your voice.

Set your Style to Hard in order to achieve robotic immediate pitch snapping, or use the Slow
setting in order to get more natural transparent results.

The setting of the Style slider will depend upon the kind of vocal sound you are going for to
fit your track.

Start with your Style slider in the middle and move either left or right while your audio is
playing back to experiment with the kind of effect you are looking for in your music.
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6. MIXER & BEAT DROP

Controls

Mixer
The Mixer section of The T-Pain Engine is where you can adjust the volume of your Beat and

Vocal tracks individually.

By default, each slider will be set to full volume.

If your Vocal 1 track is too quiet for example, click and drag the slider to the right and into
the area marked with red in order to increase the volume of your Vocal 1 track.
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If your Beat or Vocal tracks are too loud, drag the slider of any track to the left in order to
lower the volume of your audio.

Beat Drop

Click and hold on the Beat Drop button while your audio is playing back to temporarily
silence your entire Beat track. This can be particularly helpful in creating breakdowns in
your song to highlight certain vocal parts or sections.

Once you let go of the Beat Drop button, the Beat will come right back in.

Loop (&) mope

Any Beat Drops you perform will be automatically remembered and shown in your Beat
track by a red bar across your patterns.

Once you have performed your Beat Drops in your track, whenever playing your audio back,
your Beat Drops will happen automatically at the same places they were performed before.

Note : To record your Beat Drops, your audio must be playing back. You do not need to hit
the record button.

Clearing Beat Drops

If you made a mistake when clicking in your Beat Drops, you can clear any remembered
Beat Drop information by selecting the Clear Beat Drop Regions option from the Edit menu.
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If you don't want to remove all Beat Drops in your song, make a selection in the tracks view
that contains the beats you wish to restore and click the Clear Selected Beat Drop Regions
option from the Edit menu.

its | Beat Drop | Help

Clear Selected Beat Drop Regions

Clear All Beat Drop Regions L}

¥ Quantize Beat Drop

Quantize Beat Drop

When clicking on the Beat Drop button, you may not always click exactly in time with your
song. With the Quantize Beat Drop option you can make sure that Beat Drop will silence
your beat only at the next musical beat in your song.

By default, Quantize Beat Drop is on in your Preferences menu.

ts | Beat Drop | Help

Clear Selected Beat Drop Regions

Clear All Beat Drop Regions

v Quantize Beat Drop

This can help to make your Beat Drops occur exactly in time with your music, making them
sound more natural.

55



The T-Pain Engine Help Documentation

6. MIXER & BEAT DROP

Effects

Reverb
Another important factor when determining the appropriate levels for your Beats and Vocals
is the amount of reverb that you have on your vocals.

Reverb is an effect that gives a Vocal its sense of space and creates the effect of a singer is
singing in a bathroom, or cathedral, or small jazz club for example.

When used in the right amounts, reverb can enhance your Vocal takes and give them polish
and shine that will bring your entire song up a notch.

If too much reverb is present however, your recording can sound cluttered, less punchy and
washed out, similar to listening to music through a stereo in the middle of a gymnasium.

The T-Pain Engine can add Small, Medium, Large or No reverb to your Vocal 1 and 2 tracks.
This can be set inside of your T-Pain Engine Preferences window.

Edit | Effects | Beat Drop Help
Reverb Type v Small

Medium

{ v Enable Vocal 1 Reverb
Large

v" Enable Vocal 2 Reverb

IRTIT TR
By default, The T-Pain Engine will add the Small reverb setting to your Vocal tracks.

The "correct" amount will depend upon the particular style of vocals you are working with
and how you want those vocals to sound with respect to the style of your Beats.

A good starting point is to begin with the Small setting, and to experiment with Medium,
then Large, and then No reverb to see which setting makes your vocals sound the best.
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6. MIXER & BEAT DROP

Tips & Tricks

Mixing

The goal of your mix is to set the volume of your individual tracks so that it will be pleasing
for anyone to listen to. This also includes making sure that your overall mix is not so loud
that it is painful for someone to listen to, but also not so quiet that it doesn't feel like a
satisfying piece of music.

You can start by getting your track volumes at the rough levels that you'd like them, and
then making small volume adjustments later to each track to fine tune your song.

Beats vs. Vocals
In most cases, your Vocal tracks should be slightly louder than your Beat track so that any
listener can clearly hear your recorded vocals.

If your Vocal takes are too low with respect to your Beat, it can be difficult for the listener to
make out the words of your Vocals and the detail in your recording can get swallowed by
the Beat track.

If your Vocal takes are too loud however, your track can be unpleasant to listen to and can
make your Vocals sound too separate from your Beat. This can also make your overall track
feel like two separate pieces of music as opposed to one cohesive song.

At the same time, you want to make sure that your Beats are loud enough that they can
provide a backdrop and foundation for the vocal takes to sit on.

With some experimentation, you can find the right balance between the volume of your
Beats and Vocals so that they work well together and allow a listener to clearly hear both
your Beat as well as your Vocals.

Tip : If you're having trouble finding the right balance, try listening to a different song that
you like the sound of that is similar to your own track. Take notice of how loud the vocals
are with respect to the instruments and use this as a guide in setting your own Beat and
Vocal levels.

Background Vocals
If one of your Vocal takes contains background vocal recordings, it is important to set the
volume and reverb level of your vocals accordingly.

Background vocals should be loud enough that they can be heard and enhance your song,
however not loud enough to distract the listener from the lead vocal recording.

You can also experiment with setting the Vocal track containing your background vocals to
either a Medium or Large reverb setting. This can often help to place them into the correct
position in your mix to fill their role as background vocals.

Individual Parts

If you have created or recorded a particular Beat or Vocal take that you would like to export
as an individual audio file, use the Mute buttons to silence the tracks you don't want to
hear.
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Clicking on the Export button with certain tracks muted will allow you to save out only your
Beat or only your Vocal 2 recording, for example.
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7. THET -PAIN EFFECT PLUG -IN

Basics

The T-Pain Effect is a real-time audio effect that is designed to correct any incoming vocal
pitches to a musical key or scale.

'.‘TII-_!_.ij__-Fl_llllluu.

The T-Pain Effect works by first recognizing the pitch of the audio that is being played
through it, and then adjusting the pitch of that audio until it matches the nearest pitch of
the key and scale The T-Pain Effect is set to.
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Use the drop down Key and Scale menus to select between any key root note and a
collection of scales

W iror
M ajor Pentatonic o
Minor Pentatonic

The T-Pain Effect will only work on monophonic music. That is to say, music or a vocal that
only has one pitch at a time.

If you have vocals with harmony parts running through The T-Pain Effect together, the
effect will not know which pitch to use.
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7. THET -PAIN EFFECT PLUG -IN

Lo ading

The T-Pain Effect is an audio plug-in, meaning that is designed to run inside of another host
audio application such as Pro Tools or GarageBand rather than being its own standalone
application.

There are many different plug-in formats for both Windows and Mac computers. The T-Pain
Effect plug-in behaves the same way in all formats on both Windows and Mac.

These different formats are simply different ways that an audio application like Pro Tools will
read and load The T-Pain Effect plug-in.

When installing The T-Pain Engine, any available plug-in formats for your Windows or Mac
computer will be installed by default.

After installing The T-Pain Engine, it may help to restart your computer in order to have
your newly installed plug-in files recognized by your host application.

Once The T-Pain Effect is installed and recognized, each audio application has a different
way of loading external audio plug-ins.

Please refer to the Help Documentation for your particular audio host such as Pro Tools or
GarageBand for specific instructions on how to load external audio plug-ins.

Windows PC
On windows, one of the most common plug-in format for hosts is called the VST format.

If your VST plug-in is not available in a VST hostapp, there are a few things we can check:
- Some hosts might not show newly-installed plug-ins until their plug-in lists are manually
"refreshed." This is sometimes the case in hosts such as Cakewalk SONAR, FL Studio and

Adobe Audition, and there should be an option within the host to trigger a manual refresh.

- Your VST plug-in's .DLL file may not be present, or its location may not be recognized by
your VST host app. To fix this problem:

1. To begin, please close any open VST host apps.
2. Use the Windows Search option to locate the VST plug-in files on your system.
There will be two files that need to stay together in the same folder.
iZTPainEffect.dll
The T-Pain Effect.dll
Please be sure to include all hard drives among your search locations.

4. If the plug-in .DLL can't be found anywhere on your system, it's possible that the VST
component was disabled in the installer.
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Please try running the plug-in installer once again, and when it asks which components to
install, make sure that the "VST" box is checked.

5. If you locate the plug-in's .DLL file, please note its location on your system.

In most cases, your VST plug-ins are installed to your system's VST folder, typically:
C:\\Program Files\Steinberg\Vstplugins

6. Once you know the location of your plug-in file, please re-open your host app. Among

your host's preferences, it should include a list of VST plug-in folders it recognizes. Please

make sure that the full path (or location) of your VST plug-in appears in this list.

Macintosh OS X

On Macintosh systems, one of the most common plug-in formats is called the AudioUnit

(AU) format. This is the format used by Garageband and Logic and many other Macintosh

audio host applications.

If you are having trouble getting The T-Pain Effect plug-in to show up in your host, there
are a few steps we can try.

1. For the plug-in to function correctly, the AU component file must be installed to a specific
location on your system drive.

Navigate to the folder below and look for a file named

"iZTPainEffectAUHook.component”

Macintosh HD/Library/Audio/Plug-Ins/Components
2. If the plug-in file is present there, it's possible your operating system failed to detect it.
Try moving the file elsewhere, restarting your system, then moving the file back, and

restarting again.

3. If your plug-in's component file is not there, use Spotlight on your Mac to do a search for
the "iZTPainEffectAUHook.component"” file on your computer.

If it shows up in another location, please try copying it to the Components folder above, and
see if this corrects the problem.
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7. THET -PAIN EFFECT PLUG -IN

Key
Here you can define the root note or key that your vocal takes are in.

It is important to set an accurate Root Note as this can help the algorithm to determine the
best possible pitches for your particular session.

Experiment with different settings in order to find the right key center for your track or to
explore new possibilities or vocal ideas.

Often times, using keys different from the 'correct' key for your track can point you to new
musical ideas that you may not have thought of otherwise.
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7. THET -PAIN EFFECT PLUG -IN

Scale

Here you can select to snap your incoming vocal pitches to either a Chromatic, Major,
Minor, Major Pentatonic, Minor Pentatonic or Custom Scale of your choosing based upon
your specified Root Note.
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Major Pentatonic
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Each Scale has their own unique flavor to fit your music so be sure to experiment with
different scale types in order to find what fits best for your particular track.

Working with a Scale type that may not be the 'correct' scale type for your music can also
help create new vocal musical ideas for your track.

Chromatic
A Scale in which every note of every octave will be available as a pitch your vocals could be
corrected to.

If you are not sure of the Scale that your vocal takes are in, be sure to set your Scale to
Chromatic in order to get the best results.

Note : When in chromatic mode, as every pitched note is available for pitch correction, the
defined key has no effect.

Custom

When defining a Custom Scale, click once upon the notes of the keyboard you wish to
enable as options for The T-Pain Effect.
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Major Pentatonic
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The T-Pain Effect will use any notes that appear pressed down (darker) in your custom
scale.
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7. THET -PAIN EFFECT PLUG -IN

Style

You can use the Style control in order to control how quickly your incoming vocals will be
snapped to any particular note in your Key and Scale. This will essentially determine the
Style of The T-Pain Effect's processing on your voice.
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Set your Style to Hard in order to achieve robotic immediate pitch snapping, or use the Slow
setting in order to get more natural transparent results.

The setting of the Style slider will depend upon the kind of vocal sound you are going for to
fit your track.

Start with your Style slider in the middle and move either left or right while your audio is
playing back to experiment with the kind of effect you are looking for in your music.

66



iDrum: T -Pain Edition
8. IDRUM
For more information, please refer to the full iDrum Help Documentation. You can find this

Help Documentation in your installed iZotope directory or with iDrum visible, select 'Help'
from the drop -down iDrum Menu in the upper left corner o f the interface.

Basics

iDrum is a virtual drum machine that allows you to create your own drum patterns either
with its pre-loaded sounds or by loading your own .wav or .aiff files. iDrum is similar to
hardware drum machines that use what is called "step sequencing" to build patterns and
songs.

With step sequencing, the drum machine loops over and over again, allowing you to enter
notes on each track at different "steps" which each represent a rhythmic note in time. Each
track in iDrum holds a different rhythmic sound, and many tracks together create a whole
drum kit, allowing for unlimited possibilities!

In addition to working as its own sequencer, you can load iDrum into your favorite host
sequencer and trigger each of its tracks from a MIDI track in your project.

To get started with iDrum, we recommend you play with it! Start with the drum kits and
patterns we've included to get a feel for how iDrum works. If you're new to the concept of
programming a drum machine, start by loading a preset. Then click on the rectangles in the
step sequencer to change the patterns. Drag up and down to change the loudness of each
of the drum hits. iDrum lets you create new patterns quickly. When you're ready, start
loading in your own .wav or .aiff files and experiment. And remember, have fun!
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8. IDRUM

For more information, please refer to the full iDrum Help Documentation. You can find this
Help Documentation in your installed iZotope directory or with iDrum visible, select 'Help'
from the drop -down iDrum Menu in the upper left corner of the interface.

Track Controls

PATTERR:  Intro Fill
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1. Menu Button - Bring up iDrum's menu.

2. Note Division View - Change the current note division view - use this to enter different
note values (32nd notes, 64th notes).

3. Track Grab Tab - Grab tracks here to rearrange them.
4. Replace Sample - Search for a new sound to load into the track.

5. Previous/Next Sample - Step through and preview the sounds in the current sample's
folder.

6. Bang Button - Lights up to indicate when the track has been triggered. Click to preview
the sound loaded on the track.

7. File Name/Selector - Shows the name of the currently loaded sample. Click-hold on the
name to bring up a menu of all files in the same folder.

8. Pan Knob - Move the track's output in the stereo field.
9. Volume - Set the track's volume.
10. Mute and Solo Buttons - Mute (silence) or solo the track (silence all other tracks).

11. Step Programmer - Click on a square, or step, to add a note to the drum pattern.
Drag up and down to make the note louder or quieter.
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8. IDRUM

For more information, please refer to the full iDrum Help Documentation. You can find this
Help Documentation in your installed iZotope directory or with iDrum visible, select 'Help'
from the drop -down i Drum Menu in the upper left corner of the interface.

Master Section
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1. Add Track - Add a new track/sample to the track window.

2. Delete Track - Delete the currently selected track.
3. Info Panel - Open or close the track info panel.

4. Song Mo de Editor - Opens the Song Editor window which lets you chain patterns
together to create a song.

5. Song Mode - Toggle song mode on or off.

6. Time Signature - Set the time signature or meter of the current pattern. This
determines the number of steps in a pattern.

7. Pattern Selector - Set the currently playing pattern.

8. Record - Puts iDrum into record mode. Whatever you play is recorded into the current
pattern.

9. Play/Stop - Starts and stops playback. Has no effect when 'Slave to Host' is engaged.
10. Swing - Adjusts the spacing of notes in the iDrum pattern for a "swing" feel.
11. Groove - Humanizes the feel of patterns in a method similar to vintage drum machines.

12. Tempo - Indicates the tempo, or playback speed, of an iDrum song or pattern. Drag up
or down to change tempo.

13. MIDI Drag - Click drag on this icon to drag a MIDI file of the current pattern. Use this
to bring the iDrum pattern's MIDI notes into another sequencer.

14. Slave ToHost - When running in a host application like GarageBand, Logic, Pro Tools
or SONAR, links iDrum's tempo and transport to the host's.
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8. IDRUM
For more information, please refer to the full iDrum Help Documentation. You can find this
Help Documentation in your installed iZotope directory or with iDrum visible, select 'Help'

from the drop -down iDrum Menu in the upper left corner of the interface.

Track Info Panel

Track 5 Output:
Choke Group:

Mapping

MID Channel
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1. Choke Group - Sets the choke group the selected track belongs to.
2. MIDI Note - Sets the MIDI note that the current track will be triggered by.

3. Auto -Map - Turns on 'Auto-Map' for the selected track: the next received MIDI note will
automatically be set as this track's MIDI note.

4. Pitch - Sets the pitch of the loaded sample.

5. Reset Pitch - Sets the pitch to normal for the loaded sample.

6. Fit - Automatically finds the proper tuning to stretch/compress the current sample to be
exactly one bar long. This is useful when the loaded track contains a loop and you want to

sync it to iDrum's tempo

7. Decay - Sets the decay of the sample.
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8. Bit Reduction - Sets the bit depth of the current sample. Lower values give crunchier,

retro results.
9. Highpass

10. Lowpass

72

- Sets the cutoff frequency for the track's highpass filter.

- Sets the cutoff frequency for the track's lowpass filter.
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8. IDRUM

For more information, please refer to the full iDrum Help Documentation. You can find this
Help Documentation in your installed iZotope directory or with iDrum visible, select 'Help'
from the drop -down iDrum Menu in  the upper left corner of the interface.

Patterns

A part (also called a 'track Part') is a collection of 64 steps that each represent a sixty-
fourth note in a single bar of 4/4 time. By default, iDrum displays sixteenth notes for a
single bar, but you can edit 32nd and 64th notes by using the step view control at the top of
the UI.

Looking at the iDrum step programmer with the default '16' step resolution set, the first
step would be the downbeat, "one", the fifth step, "two", and so on.

A classic "four-on-the-floor" pattern would look like this:
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Parts also store the relative volume of each step, so a groovy "off-beat" hat part with
accents on the "and" of each beat would look like this:

You edit a part by clicking on a step to toggle it on or off. When a step is active, it appears
'lit up'. An inactive step appears 'greyed out'. When a step is inactive, that step is not
sounded regardless of any other settings for the part.

When a step is active, you can change the volume of the step by clicking on the step,

holding down the mouse button, and dragging up or down. A step with its volume at zero
has the same effect as an inactive step: no sample is triggered for that step.
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8. IDRUM

For more information, please refer to the full iDrum Help Documentation. You can find this
Help Documentation in your installed iZotope directory or with iDrum visible, select 'Help'
from the drop -down iDrum Menu in the upper left corner of the interface.

Record a Pattern

As we mentioned, you can create or change drum patterns by turning off the rectangular
"steps" in iDrum's interface. However, there is a second option for making patterns--you
can record them from a MIDI controller or even your computer keyboard.

Enable the Record button in iDrum, and as you play notes on your MIDI or computer
keyboard iDrum will capture them into your pattern.

Computer (QWERTY) Keyboard

Using the letters in the second row (beginning with "A") on your computer keyboard, you
can trigger each of iDrum's tracks. "A" corresponds to the first track in iDrum, S the second,
and so on down the row.

MIDI Keyboard

iDrum's tracks respond to MIDI notes. This means you can use a MIDI keyboard or pad
controller to play and record patterns in iDrum. You can also reassign each of iDrum's tracks
to respond to any MIDI note you want. See the "Change Trigger Note" topic in this help file
for details.

Quantize Input

You can tell iDrum to correct your timing as you record patterns by using the Quantize Input
settings in the iDrum menu. This feature will automatically adjust the rhythm of the notes
you play to fit into iDrum's grid, even if your timing isn't perfect.

For most situations, try setting input quantize to 16th notes or 8th notes - these are the
most forgiving settings. If you want notes to be captured more precisely, try the 32nd or
64th note settings.
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